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Dynamic Range

• What is dynamic range?
• What is low or limited dynamic range (LDR)?
• What is high dynamic range (HDR)?
• What’s the difference?
• Since we normally work in LDR

– Why it is advantageous, in most cases, to increase
the dynamic range of your image.

– How you can obtain the highest dynamic range
possible within LDR.



Dynamic Range

Dynamic range in photography defines
the ratio between the maximum and
minimum measurable light intensity
(white and black, respectively).



Dynamic Range

• White (lightest) is easiest to measure
(white of paper). Small differences are
easily visible.

• Black (darkest) is harder to measure as it
may be unclear where differences are no
longer discernable.



Dynamic Range

Dynamic range in photography is
measured in terms of f-stops.

Each increase of an f-stop represents a
doubling of the amount of light.



Dynamic Range
of various devices

• Slide Film – about 4 f-stops
• Negative Film – about 6 f-stops
• Digital Camera – about 6 f-stops
• Human eye – 10-12 f-stops.
• If we include the ability of iris to open and

close – 24 f-stops



Digital images

• All of the devices we use are Low (or
limited) dynamic range and set limits on
the range available.
– camera - sensor elements (like a cup)
– monitor - pixel brightness
– printer - ink and printer drops

• Highest value in file = Brightest tone that
can be measured or displayed.



Computer Representation of Color is limited
 8 or 24 bit color

• 3 colors (Red, Green, Blue)
• Each color is represented by “8 bits” of

information
•       Red    – 256 levels
          Green – 256 levels
          Blue   – 256 levels
• Total 16,777,216 levels of color which is more

than the eye can discern.
• But range still limited by device (camera, printer)



Computer Representation of Color is limited
 16 or 48 bit color

• 3 colors (Red, Green, Blue)
• Each color is represented by “16 bits” of information
•       Red    – 65,536  levels
          Green – 65,536  levels
          Blue   – 65,536  levels
• Total 281,474,976,710,656 levels of color which is more

than the eye can discern.
– More gradations (shades) available with 16 bit than 8 bit
– But the dynamic range is still the same, limited by device

(camera, printer)



Low (limited) Dynamic Range
• The Dynamic Range is limited by our devices (camera,

monitor, printer).
• We will look at techniques and methods to maximize the

dynamic range within the system
• Discuss the newer concept of High Dynamic Range and

how it works.



Dynamic Range

• One problem in photography has always
been the rendering of scenes with bright
lights and dark shadows. It was true with
film and is still true with digital
photography.



Limited Dynamic Range in
Photography

3.2 sec  f111/20 sec  f11

6 f-stops



Limited Dynamic Range in
Photography

• The eye can see a much greater dynamic
range than is possible in a camera.

• How can we produce photographs that get
around the limited range?



Histogram

• The ability to view and utilize a histogram is a
great advantage of digital over film.

• Represents tone (brightness) at any point in the
dynamic range – It is brightness and not color.

• Values can be between 0 and 255.
– Limited by

• Input devices (camera, scanner)
• Viewers – screen
• Output – printer, projector





“Good” histogram:
No or minimal pixels at either end
No breaks in curve 
Uses entire tonal range

Histogram represents the number of 
pixels at each tonal value or brightness
Between:
0 = Pure Black
255 = Pure White

255



“Bad” histogram:
Pixels at right (white) = blown out
Breaks in curve  = posterization 
(not continuous color)

Histogram represents the number of 
pixels at each tonal value or brightness
Between:
0 = Pure Black
255 = Pure White

255



“Bad” histogram:
Pixels at left (black) = no details
in shadows.

Breaks in curve  = posterization

Histogram represents the number of 
pixels at each tonal value or brightness
Between:
0 = Pure Black
255 = Pure White

255



“Good” histogram:
No or minimal pixels at either end
No breaks in curve
Uses entire tonal range 

Histogram
represents the
number of
pixels at each tonal
value or brightness
Between:
0 = Pure Black
255 = Pure White

255



Should one always
 Optimize the Histogram ?

• Some images look best with a Limited
Dynamic Range.
– Photograph in the fog.
– Effect of low contrast.
– Silhouettes
– You may like the effect of dark shadows or

very light highlights.









Dynamic Range of Digital Camera
f 5.6, Iso 100
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Dynamic Range

• How can you assure that you are getting
the highest dynamic range possible?

– When taking photograph
– When processing photograph



Methods of increasing dynamic
range of image

While taking photograph:
• Take photo with graduated neutral density

filter.
• Use Fill Flash
• Shoot to right of histogram (expose for

brightest) – most important with JPG
• Take photo in RAW &16 bit rather than

JPG & 8 bit.
• Keep file as RAW (do not convert to JPG).



Use Fill Flash

3.2 sec  f111/20 sec  f11

1/20 sec f11
With fill flash



Methods of increasing dynamic
range of image

• “Shoot to right”
– In theory, since 50% of range is in the

brightest f-stop you will get more
information by letting curve almost
reach the right side of histogram.



Increasing f-stop by 1 increases
dynamic range by 60 or 30%

0 50 100 150 200 250

0 f stop

1 f stop

2 f stop

3 f stop

4 f stop

5 f stop

6 f stop

If this is highest tone in image
 – 180 possible tonal values can 
be represented.

If this is highest tone in image
 – 240 possible tonal values can 
be represented.



Greater range of tones with exposure to
right (5 f-stops difference)

0.8 sec
at f 5.6

1/40 (.025) sec 
at f 5.6



Methods of increasing dynamic
range of image

• Leave file as 16 bit rather than 8 bit until
you are finished manipulating it in
photoshop.
– RAW, PSD, TIF can be 8 or 16 bit.
– JPG can only be 8 bit



Consider 8 bit image at dark end of tonal spectrum
Spread out to increase dynamic range



Consider 16 bit image at dark end of tonal spectrum
 Spread out to increase dynamic range

8 bit

16 bit



Original Image



Use Levels to Increase
Dynamic Range

8 bit

16 bit

Original



When converting RAW to JPG
 the camera must:

• Decrease 16 bits to 8 bits.
• De-mosaicize each pixel.
• Apply White Balance.
• Enhance with (sharpness, brightness,

contrast, saturation) as per camera or you.
• Apply gamma (curve correction).
• Compress data.



Advantages of RAW over JPG

• Keeping 16 bits avoids posterization
especially if you will be increasing the
tonal range of the image.

• Allows more details in opening up the
shadows.



Advantages of RAW over JPG

• De-mosaicizing each pixel is very
computer processor intensive.

• Better algorithm in computer than in
camera.



Advantages of RAW over JPG

• JPG makes white balance changes.
• RAW retains flexibility to correct white

balance or to use any white balance you
choose after taking the photograph.



Advantages of RAW over JPG

• JPG makes changes in contrast,
brightness, saturation and sharpness that
either the camera manufacturer or you
have pre-determined.

• This might not be correct for your specific
photo (need different adjustments for
portraits, fog photos, landscapes, flowers
etc.)

• Any change destroys data.



Advantages of RAW over JPG

• JPG applies a “gamma” curve.
• RAW lets you do this to your own

specifications (contrast enhancement).



Advantages of RAW over JPG

• JPG looses data when it compresses
image.

• RAW has no compression so you are
making improvements on all available
data.



Advantage of RAW over JPG
Exposed for no blow-out

RAW JPG

RAW JPG



Advantage of RAW over JPG
Exposed for no blow-out

opening shadows with shadow/highlight adjustment

RAW JPG

RAW JPG

Better opening of shadows and less noise with RAW



Image Saved as .tif vs .jpg

Saved as .tif file Saved as medium .jpg
opened once



Disadvantages of RAW vs JPG

• RAW files are larger than JPG therefore get
fewer shots on a card and takes longer for
camera to copy to card.

• RAW files are proprietary and therefore
information is at the whim of company. (?DNG).

• RAW requires extra steps when you process
them which may be time consuming if you took
1000 photos of an wedding.



Disadvantages of RAW vs JPG

• RAW files have not been altered by
camera (contrast, brightness, saturation,
sharpness) and are therefore darker, lack
contrast, less saturated than jpg

Unless you modify in Photoshop.



Most images look best when the
dynamic range is optimized

Therefore it is usually
advantageous to use Photoshop
to optimize the image.



Methods of increasing dynamic
range of image

after you have taken photograph
• Single photo –

– Set white and black points in levels or curves
– Modify with Shadow/Highlight Adjustment
– Modify with curves or levels and masks
– Modify in Camera RAW using “fill light”

• Combine 2 photos (Expose for highlights/shadows)
– Blend 2 images (Exposure Blending)
– Blend CS4 Auto Align/Smart Object>stack mode>mean

• Combine 3 or more photos
– Blend with HDR
– Blend CS4 Auto Align/Smart Object>stack mode>mean



Increasing Dynamic Range
in One Image



Setting black and white points



Problem with expanding histogram

• Limited range of tones may lead to
posterization

• Noise in shadows may become more
visible.

• Can be minimized by manipulating as 16
bit rather than 8 bit.



Image as seen by
Eye and Camera

Eye Camera 
(using meter)



Enhancing Dynamic Range of
Single Image in computer

Photograph using metered exposure



Attempt to improve single image with
Shadow/Highlight Tool

Original Shadow/Highlight
Adjustment in Photoshop



Photograph
Using -3 f-stops (no blow out)



Photograph
Using -3 f-stops (no blow out)

 Shadow/Highlight Tool



Unmodified Digital Photograph
(taken with no blow-out)



Digital Photograph
Brightness increased in Photoshop



Digital Photograph
Modified in Adobe RAW



Combining 2 exposures

- 4 f-stops + 2 f-stops



Combining 2 exposures
Make mask from lighter exposure to mask darker exposure



Combining images in CS4
• Take 2 or more images
• In Adobe RAW Converter go to

– Tools>Photoshop>Load Files into Photoshop Layers
– Select all layers

• In Photoshop:
– Edit>Auto-align layers
– With all layers selected: Layers> Smart

Object>Convert to Smart Object
– Layer>Smart Object>Stack Mode>Mean



Combining 2 exposures
Utilize CS4 Auto Align/Smart Object>stack mode>mean



HDR

• High Dynamic Range (HDR) is a new
method of recording light in the computer.

• Use 32 bits (not 8 or 16) but in a different
way.

• Enables the computer to record light
across an infinite dynamic range.



Shooting an HDR image
• Use Tripod
• Set camera to manual exposure setting with appropriate f-stop

and lowest ISO.
• Take exposure using appropriate shutter speed.
• Slow down shutter speed (more light) by 1 to 2 f-stops and look

at histogram. Do this until well away from left end and details are
seen in shadows which are noise free.

• When satisfactory go back to original shutter speed and do the
same thing by speeding up shutter speed and right end of
histogram so no blown highlights.

• Can have any number of exposures (usually 3 or more)
• May be able to use Auto-exposure bracketing if it allows +/- 2 f

stops and range sufficient.
• Combine images with HDR tool in Photoshop or use Add-in

(Photomatrix etc.)



How does the computer do it?

• The computer records the amount of light
at the pixel.

• It also knows how many f-stops +/- it was
exposed with.

• Therefore a pixel with a value of 127 taken
-2 f/stops will be lighter than another pixel
with a value of 127 taken +2 f/stops.



Viewing an HDR image

• The monitor is LDR and therefore cannot
represent the entire range of tonalities
present in an HDR file.

• Neither can the printer.
• To represent the HDR image on the

monitor or printer, must compress the
tonal range resulting in an image with little
contrast.



Methods to view HDR on a monitor

• Exposure Blending:
– Merges different sections of differently

exposed photographs into an image with
details in all areas. This is essentially what
you do with two images and masks.

• Tonal mapping:
– Compresses tonal data to display on monitor.



Tonal mapping

• Global operators:
– Each pixel is mapped to a visible range

according to it’s intensity in the HDR file.
– Results in a flat image with little contrast.

• Local operators:
– Pixel location is taken into account so a pixel

will be mapped differently depending whether
it is in a dark or light area.

– Preserves local contrast.



Tonal mapping in CS4
• Exposure and Gamma

– Lets you adjust the exposure and gamma = brightness and contrast.

• Highlight Compression
– Compresses highlights, may lose shadow details. No user adjustments.

• Equalize Histogram
– This method attempts to redistribute the extremes in the HDR histogram

into the contrast range of a normal 16 or 8-bit image. No user
adjustments.

• Local Adaptation
– Changes how much it brightens or darkens regions on a per-pixel basis

(similar to local contrast enhancement).  This has the effect of tricking
the eye into thinking that the image has more contrast. Allows the most
flexibility.



Image as seen by
Eye and Camera

Eye Camera
(metered exposure)



Here is a Solution



-2 f-stops, Metered, +3 f-stops

1/50 sec at f 111/200 sec at f 11
- 2 f-stops

1/6 sec at f 11
+ 3 f-stops



-2 f-stops, Metered, +3 f-stops
Combining with stacks/smart object/mean



Improvement with
Shadows/Highlights Adjustment

Use of 
Shadow/Highlights1/200 sec at f 11

- 2 f-stops



Combining 2 exposures
Gradient Mask (mimic Neutral Density Filter)



Combining 2 exposures
Make mask from lighter to mask darker



HDR (4 methods)
Exposure & Gamma Highlight Compression

Equalize Histogram Local Adoptation



-2, +4f-stops



HDR (4 methods)
Exposure & Gamma Highlight Compression

Equalize Histogram Local Adaptation



Dynamic Range
Summary

• Dynamic range in photography defines the
ratio between the maximum and minimum
measurable light intensities (white and
black, respectively).

• While our eye can see a dynamic range of
12 f-stops, the camera can only visualize
about 6 f-stops



Dynamic Range
Summary

• In most cases maximizing the dynamic range
increases details, enhances color minimizes
noise, especially in the shadows and makes for
a more pleasing photograph.

• There are many different ways to increase
dynamic range. Which one you use depends on
the circumstance and your familiarity with a
technique.



Dynamic Range
Summary

• As with most photography, the best
method is to “capture the picture correctly
in the camera.”

• You can increase your chances of
maximizing dynamic range by shooting
RAW, 16 bit, and “shooting to the right”.

• You can also use a graduated neutral
density filter or fill-flash in some cases.



Dynamic Range
Summary

• If there are no blown highlights, and the
shadows are not too compressed,
dynamic range may be increased with
adjustments (especially shadow/highlights)
in Photoshop.



Dynamic Range
Summary

• If the dynamic range is too great to
capture in one exposure, use two
exposures and combine using masks or
other methods.



Dynamic Range
Summary

• If the usable dynamic range is greater than can be
captured in two photographs - may require HDR.

• HDR is a relatively new method of greatly expanding
the dynamic range over a wider range.

• HDR allows one to compress a very large range into
an image.

• The tools to accomplish this are still in their infancy
and may be difficult to use. Over time they will
become easier to use and more sophisticated.



Dynamic Range
Summary

• There is a basic HDR function in Photoshop CS4
• Photomatrix Pro is a standalone program for

Windows or Mac.
• Others available - including some open source.
• Now available in camera with Pentax K-7, K-x (3

exposures) and Sony DSLR A550 (2
exposures).


